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Chapter 1 - Introduction
1.1 Introduction
This manual describes the theory and operation of the PUMA Vibration Control System
(VCS) when running the Sine on Sine on Random Application. Note that the Receiving
Checkout Tests (RCT’s) are used as examples and should be referred to often.
This manual is presented in nine chapters relating information about the applicable menus
required to set up the operating parameters for the Puma Vibration Controller.

1.2 Getting Started
Before you begin, read the PUMA System Description Manual. This will help familiarize
the user with the system, and give required information for unpacking, assembly and
operation.

1.3

Software and Manuals

Software and manuals (along with vendor manuals, calibration devices and service
training) are sold in various combinations.

1.3.1 Software
The Sine on Random closed-loop vibration control program and options are supplied on
CD ROM. This CD ROM contains executable code for Sine on Random, test parameters,
schedule parameters and the micro code for peripheral devices. The software is licensed
and requires a key to activate it. The key and drivers are supplied on diskette.
1.3.2 Manuals
The PUMA VCS is supplied with a set of two system manuals and an application manual.
q

PUMA System Description
Part Number 2400-0100

Other manuals may be included as purchase options.
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1.4 Sine on Random Features
The PUMA VCS and the Sine on Random program provide digital real-time closed loop
shaker control for production testing, design qualification and reliability testing
applications. The system allows the definition, simulation, and closed loop control of
Sine on Random vibration excitation of a vibration shaker system.
The principal features of the Sine on Sine on Random software are:
q

Reference Spectrum – Up to 500 amplitude/frequency breakpoints/slopes

q

Frequency Ranges – 50 to 20,000 Hz (in eight ranges)

q

Resolution – 100, 200, 400 & 800 lines; expandable to include 1,600 and 3,200
lines

q

Degrees of Freedom (DOF) – User defined (8 to 1,000)

q

Control Accuracy - ± 1 dB for flat reference with 120 DOF with 90% statistical
coincidence

q

Output Type – True Gaussian Sine on Random noise

q

Sigma Clipping – Off, 2.5 to 6 sigma

q

Control Strategy – Single point, multi-point average or extremal

q

Automatic Operation – Selectable equalization start level, initial test level,
level increment, time to full test level, startup rate and shutdown rate.

q

Level Scheduling – User defined level, time at level, transition time to each level

q

Test Schedule – User defined sequence of independent tests can be scheduled to
run automatically

q

On Line Controls – Step Level Up, Step Level Down, Full Level, Pause, Resume,
Drive Update On/Off

q

Analysis Function – Power Spectral Density (PSD) for control, auxiliary
channels, drive, error functions, transfer functions (mag, phase
& coherence), transmissibility and time traces.

1.4.1 Safety Features
Sine on Sine on Random provides the following safety features to protect the operator,
the test equipment and the manufacturing operations:
q

Shaker Limits

q

Password login to prevent unauthorized system operation (optional)

q

Alarm / Abort messages to indicate abnormal test conditions

q

Alarm / Abort tolerance limits set by the operator for each spectral line
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q

Total overall acceleration RMS Alarm / Abort level operator settings for the
acceleration spectrum

q

User specified active frequency range for Alarm / Abort conditions

q

A loop check continuity test automatically precedes each test

q

Sigma clipping to prevent drive level from exceeding a threshold value

q

Controlled test startup / shutdown rates

q

Aborted testing for any control signal loss or excessive fluctuation

q

Manual test Abort

q

Abort documentation for post-test analysis

1.4.2

Options

The following options may be purchased for use with the system.
1.4.2.1

Security

The Security Option package enables the system administrator to place limits on the
system including who has access and what level of access is available to individual users.
1.4.2.2 Automation
The Automation Option package includes RCI, RCP, Print Automation, Test Automation,
Mission Simulation and True Networking.
1.4.3

Compatible Equipment

The PUMA VCS connects to any commercially available electro-dynamic or electrohydraulic shaker and amplifier.
1.4.4

Reliability

The PUMA Vibration Controller is designed and manufactured with state-of-the-art
components and processes that improve the reliability of the system.
1.4.5 User Interface
The PUMA VCS, runs under a Microsoft Windows 95 (up to version 1.5.2), Windows 98
SE, Windows 2000 or NT 4.0 operating system. All user interaction is by keyboard and
mouse. Test setup, control and data are displayed on a high-resolution color monitor.
User help information is available for all program functions.
The color monitor provides real-time displays of:
q

Program control menus

q

Test definition parameters

q

Spectra showing test conditions, with Abort / Alarm information.

q
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Chapter 3 - Getting Started
3.1 Introduction
The Spectral Dynamics Computer Aided Test Suite (CATS) Vibration Controller
program is called Puma. It can be started by either a desktop shortcut icon or through the
Start button. The path is <Start> ï PROGRAMS ï SPECTRAL TEST SUITE ï PUMA.
3.1.1

Log In

If the Security option (see paragraph 5.2.8) is in place the User Log In Dialog Box
(Figure 3-1) appears. If there is no Security option the screen will appear as shown in
Figure 3-2. To access the features of the PUMA Vibration Controller program you must
have a valid users name and password. See the system administrator for proper users
name and passwords.
Enter a User Name and Password and
click <LOG IN>. The Puma Program Entry
Screen shown in Figure 3-2 will appear.
The Puma Version Splash screen will
disappear in several seconds (or can be
dismissed by clicking on it) leaving the
New Dialog Box from which the desired
application can be launched. Click on SINE
ON RANDOM, and then click OK.

Figure 3-1. User Log In Dialog Box

A screen similar to the SINE ON RANDOM Screen shown in Figure 3-3 appears. Exact
screen layout is dependent on the parameters previously set with the menu options under
Puma.

Puma
Shortcut
Icon

Puma
Version
Splash
Screen

NEW Dialog
Box showing
applications
available.

Figure 3-2. Puma Program Entry Screen
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Toolbars

Puma Local Window

Two Rows of Different Plots

Test Control

Status Panels

Figure 3-3. Typical PUMA Random Screen Replace later.

3.1.2 Puma Window
The Puma Window’s Title Bar displays three segments of information (Puma —Local
— Sine on Random 1). The Local next to Puma indicates the user is running on the
Local Puma system and not across the network. Sine on Random 1 is the name of the
currently loaded test. If the Puma window is inaccessible minimize or drag the Spectral
Dynamics Viewer window out of the way. Click on the Puma Window to make it the
active window to start the process of setting test parameters.
3.1.3

Random Menus

The Puma Window’s Menu Bar contains six menu selections used by the PUMA
Vibration Controller program. They are: FILE, SETUP, VIEW, TEST, DATA, and HELP.
Each of these is discussed further within their own chapter.
Using hotkeys can activate many of the menu selections. An underlined letter indicates
the character to use in conjunction with the <ALT> key. For instance, use <ALT> + <F>
to activate the File menu.
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Select LOG OUT from the FILE menu when the system is unattended, and access to the
program is to be restricted. The user must log in again to resume using the system. When
logged in, the LOG OUT menu item is available (LOG IN is grayed out).
3.1.4 Setting Up Parameters
Initiating a test is done by either starting a new one from the very beginning or by
running one that has already been predefined and saved to a file.
3.1.4.1 New Test
The SETUP Menu options are presented in Chapter 5.
Procedural Steps
1. Click SETUP ï CHANNELS. The Channel Definition Window appears. See Figure
3-4 and paragraph 5.2.1 for details.

Sensitivity
Accelerometer
Sensitivity
Range 0.01 - 106
Loop Check
Checks channels
reception of signal
thru the drive.

Channel Types
Abort - Control
Inactive - Limit
Measure
See Paragraph
5.2.1.1

RMS Abort
dB Reference
Test aborts if RMS
Value must be
exceeds entered
greater than zero.
ICP
value.
Turned ON to
power ICP type
accelerometers.

Weighting
Used with Control
Channels. Value
entered is averaged.

Reference
Channel
Can be any
or all active
channels.

Coupling
DC values are ignored
by the Control Loop. AC
is used to block DC
Offsets.

File Selection Box
(FSB) See
Paragraph 3.3.1

Figure 3-4. Channel Definition Window
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2. Input the required parameters and save them to a file.
3. Click SETUP ï BROADBAND PROFILES. The Profile Settings Window appears.
See
Figure 3-5. Refer to paragraph 5.2.4 for Profile Definition information.
4. Input the required parameters and save them to a file.
5. Click SETUP ï SCHEDULES. The Schedule Setup Window appears. See
Figure 3-6.
6. On the Level Schedule Index Tab, input the required parameters and save them to
a file.
The test is now ready to run
Status
OFF by default.
Toggled ON when
information is
entered.

Frequency
X-Axis measurement.
Must be within the
parameters set in
Profile Range below.

+/- Alarm dB Columns
Whether the test will abort or
ignore is determined by the
setting in the schedule. See
paragraph 5.2.5 for more
details.

Up to
500
Profiles
available.

+/- Abort dB
Columns
The Abort
indicator lines
are the
outermost of
the plot.
When a test
exceeds the
preset levels
indicated by
the lines, the
test aborts.

Units Of Measurement
of the Y- Axis.
An optional
slope.
Amplitude
(Y-Axis)
Units
Selection
Buttons

File
Selection
Box.
See
paragraph
3.3.1.

Plot
Preview
Window.
Plot shows
crosshairs.

Figure 3-5. Broadband Profile Settings

2400-0133

BETA RELEASE

3-5

Getting Started

Two Tabs

Sine on Random Operating Manual

Time At Level
Time spent on this
schedule prior to
continuing

Time To Level
Time period
required reaching
the next level once
current level is
finished.

Level
Column
The decibel
level
required for
this stage
of the test
Status
Column
Default is
OFF.
Toggled
ON when
info
entered.
Schedules
turned OFF
will not be
executed.

Alarm Action
The action
(Alarm / Abort)
required if data
trace exceeds
preset levels.

FSB
S`ee
paragraph
3.3.1

Acquisition Range
Start Up / Shut Down
Rate of Schedule
Level Increment - The
amount raised/lowered
between schedule
steps.
Initial Test Level - The
level at which the test
will start.
Time At Initial Level Time spent at initial
level prior to moving
to moving

500 Schedules
available using the
slider.

Figure 3-6. Schedule Setup

3.1.4.2 Existing Test
Procedural Steps
1. Click FILE ï NEW The New Dialog Box appears. See Figure 3-7.
2. Click SINE ON RANDOM ï <OK>. See Figure 3-8. The screen defaults to the one
used last.
3. Click FILE ï OPEN. See Figure 3-9.
4. Select appropriate Files of Type filter from the drop down list box.
5. Navigate to the required drive/directory (folder) the Look In drop down list box.
6. Select and open appropriate directory in the list box.
7. Select and open test file.
8. Click <OPEN> on the standard Windows File Open Dialog Box.
The test is ready to run.
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Figure 3-7. NEW Dialog Box

Figure 3-8. Results of Sine on Random ⇒ OK. Replace
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Figure 3-9. Results of File ⇒ Open

3.2 Arranging Screen Components
While running PUMA there will always be at least two windows on the screen (Puma
Window and the Spectral Dynamics Viewer Window). There can also be a test control
and various status panels. The location of these components is completely customizable.
The Desktop Toolbar in the Puma Window (Figure 3-10) allows multiple screen layouts
to be saved and recalled.
Save
Delete
Button
Button
Exit
Button

Puma
Desktop
Toolbar

Application
Toolbar

Figure 3-10. Desktop Toolbar

In the example in Figure 3-10, “Default” is the screen layout name. To create a new
layout, size the windows, arrange the plots, status panels and control as needed. Select the
name in the Puma Desktop Toolbar and enter a new name. Click the save button. Saved
layouts are available from the pull down menu button in the toolbar name box.
2400-0133
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Clicking the Exit Button launches the APPLICATION CONTROL MENU. See Figure 4-3.
This is a common Windows menu and can also be launched by right clicking the Title
Bar. One set of options is available in the maximized window presentation. Another set
of options is available from a restored size window.

3.3

Common Areas of Host Dialogs

The layout of dialog boxes sometimes differs from one menu option to another. Even
though the command buttons may be in a different position they will work the same from
one menu option or window to another.
3.3.1 File Selection Box
Throughout PUMA there is a need to save the parameters of tests, load those same
parameters for another test or just start on something brand new. The File Selection Box
(FSB) (Figure 3-11) is shown in the lower left hand corner of Figures 3-4 and 3-6 and the
lower right hand corner of Figure 3-5. It is a common Windows tool and is used
throughout the PUMA platform though sometimes the format is somewhat different. The
components of the FSB are outlined below for the primary setup areas of Channel
Definition, Profile Settings and Schedule Setup.

Figure 3-11. File Selection Box

3.3.1.1 New Selection Command Button
Active Dialog Box

Result of Selecting NEW from the File Selection Box

q

Channel Definition

The path / name of the currently open file is deleted from
the File Name text box. It does not delete the numbers from
any of the columns. It is not active during a test.

q

Profile Settings

Clears all columns of data. It is not active during a test.

q

Schedule Setup

Clears all columns of data. The path / name of the currently
open file is deleted from the File Name text box. It is not
active during a test.
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3.3.1.2 Load File Command Button
This button reacts the same way in all three parameter input areas. The Open Dialog Box
is displayed for the user to choose a file to be loaded. All three areas are active during a
test.
3.3.1.3 Save As Command Button
This button also reacts the same way in all three parameter input areas. The Save As
Dialog Box is displayed for the user to save a file. All three areas are not active during a
test.
3.3.1.4 OK Command Button
This button accepts any changes made, applies them and closes the Open Dialog Box.
3.3.1.5 Cancel Command Button
This button closes the Open Dialog Box without applying any changes that may have
been made.
3.3.1.6 Apply Command Button
This button applies any changes that have been made and keeps the dialog box open.
3.3.1.7 Help Command Button
This button launches the on-line help. If a dialog box is open it must first be closed to
launch the help menus.
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Chapter 4 - File Menu
4.1

Introduction

The first of the six menu options in the PUMA Vibration Control System (Vibration
Controller) is the FILE Menu option. Refer to the following chapters for other menu
options.

4.2

The File Menu

When the user selects FILE from the Sine On Random Menu Bar, the menu shown in
Figure 4-1 will display. The FILE menu option has 16 sub-menus and a seven-file list
(called a recent-file list) contained in a seven-section drop-down menu list. The recentfile list allows rapid access to files that have recently been used.
4.2.1

File Sub-Menus

The sub-menus (Figure 4-1) of the PUMA Sine On Random FILE Menu option are
outlined below. After the test is started, the menu options change.
4.2.1.1 New Menu Option
When NEW is selected, the New Option List Box
will display. See Figure 4-2. This will initialize the
test parameter settings for the test application
chosen. Only test applications that are licensed for
the system will appear in the box. Available test
applications are:

o

3-12

Analyzer

o

Random

q

Multi-Ref Modal Acquisition

o

Random on Random

q

Waveform Replication

o

Sine On Random

o

Rotating Machinery

o

Classical shock

o

Sine

o

Shock Synthesis
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Options During Test

Options Prior To Test

Figure 4-1. File Menu Submenus

Figure 4-2. New Option List Box

Clicking on the NEW menu option and selecting another test while working on a test will
initiate the display of a SAVE prompt unless there were no changes made to the test that
was downloaded to work on.
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4.2.1.2 Open Menu Option
The OPEN menu option allows the user to select a
previously stored test setup file. It displays a
standard Windows Open (file) Dialog Box. The
user can navigate to the desired file and open it. If
the user wants to load a different test type (e.g.
Sine) simply select the setup and Puma will
automatically change to the appropriate
application.
4.2.1.3

Close Menu Option

The CLOSE menu option closes the currently loaded test setup. When CLOSE is clicked a
SAVE prompt is displayed if the current test setup has had changes made to it. If no
changes were made the currently displayed window will close.
4.2.1.4

Save Menu Option

When SAVE is clicked the first time a standard
Windows Save As Dialog Box appears. It allows
the user to save the currently loaded test setup.
After the test has been named and saved as a file,
clicking the button will not display any visual
markers except the Save Progress Bar which
briefly displays on the Status Bar during the time
the file is being saved to disk.

4.2.1.5

Save As Menu Option

The SAVE AS Menu Option allows test setup parameters to be saved under a new file
name. This option also launches the standard Windows Save As Dialog Box.
4.2.1.6

Print Setup

PRINT SETUP is a standard Windows command that allows the user to select a printer, the
size and source of paper and the orientation of the page. These selections will affect how
things are printed when the Print option is used.

2400-0133
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Print

Click on PRINT to launch the standard Windows
Print Dialog Box. From here the user may select a
printer, what is to be printed and how many copies
are required. The option to print to a file is also
available.

4.2.1.8

Send

SEND is a standard Windows command for sending files / tests via e-mail.
4.2.1.9 Log In
If the Security Option is installed, the LOG IN option is not available when the user is
already using PUMA. It becomes available after logging out.
4.2.1.10 Log Out
If the Security Option is installed, the LOG OUT option is only available when the user is
logged in to PUMA.
4.2.1.11 System Lock/System Unlock
These two features come with the security options. When SYSTEM LOCK is selected, the
system is locked and that option becomes disabled. The SYSTEM UNLOCK option is then
enabled. To regain access to the program, the user must select SYSTEM UNLOCK. The
User Log In dialog box will display and allow you to login.
4.2.1.12 Recent File List
The recent file list is a standard Windows feature that has been adopted for Puma. It
allows the user quick access to the most recently used setup files that have been opened.
These files are also available from the Windows Start menu. The path for usage is:
<Start> ï DOCUMENTS ï File Name
4.2.1.13 Exit
EXIT is a standard Windows command. Exiting the program can be accomplished in
three ways. The user can navigate FILE ⇒ EXIT or click the Exit Button to access the
APPLICATION CONTROL MENU (Figure 4-3), or by clicking on the close button (X) in the
upper RH corner of the screen. Any of these will terminate the application.
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Options Obtained in a Maximized
Window

Options Obtained in a Restored
Window
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Figure 4-3. Application Control Menu

4.2.2 Menus Available During The Test
While a test is running, not all of the FILE Menu options are available for use. The
available FILE Menu options during a test are:
q

PRINT
SETUP

q

PRINT

q

SEND

q
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OUT

q

SYSTEM
LOCK
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Chapter 5 - Setup Menu
5.1 Introduction
The SETUP Menu is where all of the test parameters are entered for a Sine on Random
test setup. In most of the test setup submenus (e.g. channel definition) the individual test
settings may be saved in a separate file that may be recalled by another test setup to speed
creation of subsequent tests.

5.2 Submenus
The following paragraphs give
information about the nine SETUP
submenu options available. See
Figure 5-1.
5.2.1 Channels
The CHANNELS Menu option produces a
Channel Definition Window (Figure 5-2)
that allows the user to:

Figure 5-1. Setup Menus
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q
q
q
q
q
q
q
q

5.2.1.1

Print a listing of the Channel Definition settings
Change any or all of the 11 Channel Definition parameters
Open a new file
Load a previously saved test/file
Use the SaveAs option to name/save a file
Accept default / user selected file names and initiate selected action
Cancel selection / window
Get Help
Channel Definition

The Channel Definition window allows setup, recall, and storage of Puma input channel
settings. There can be 4, 10, 16 or 32 channels available for input. The Channel
Definition Window columns are defined below.
Name
Up to 20 characters can be used to designate a unique name for the
channels being used.
Serial #
Up to 20 characters can be used to designate an accelerometer serial
number for the channels being used.
Sensitivity
Accelerometer
Sensitivity
Range 0.01 - 106
Loop Check
Checks channels
reception of signal
thru the drive.

RMS Abort
Test aborts if RMS
exceeds entered
value.

dB Reference
Value must be
greater than zero.

ICP
Turned ON to
power ICP type
accelerometers.

2400-0133 BETA RELEASE

Reference
Channel
Can be any
or all active
channels.
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Channel Types
Control
Inactive
Measure
See Paragraph
5.2.1.1

Weighting
Used with Control
Channels. Value
entered is averaged.

View Menu

Coupling
DC values are ignored
by the Control Loop. AC
is used to block DC
Offsets.

File Selection Box
(FSB) See
Paragraph 3.3.1

Figure 5-2. Channel Definition Window Change graphic

Type
Select from three channel types:
q

Inactive – Channel is off and no data is acquired.

q

Control – Channel defined at a control point on the device under
test (DUT). There may be multiple control channels, but a
minimum of one is required. It is the default.

q

Measure –An active channel used to measure data at other points
on the DUT. It is not used to modify the drive. Loop check is
optional.

Loop Check
The Loop Chk is used to check the channel's reception of the signal being
sent through the drive. It can be either On or Off. When ON, an open
channel “Safety” check is performed before the test is run.
Sensitivity mv/g
Accelerometer sensitivity is entered in milli-volts per g. Range is 0.01 to
1,000,000.
Weighting (dB)
Weighting is used in multi-channel average control (more than one control
channel) to weight one channel vs. another. If several control channels are
used and the highest is 3 while the lowest is 1, there is a 3:1 ratio
throughout the channels.
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RMS Abort (GRMS)
This safety parameter provides an abort of the test if the level on that
channel exceeds the RMS Abort level.
ICP
The ICPfunction can either be On or Off. It provides a constant DC
current source to power ICP type accelerometers. AC coupling must be on
to use this feature.
Coupling
Input channel coupling:
q

AC Coupling – It is used to block the DC component of the signal.

q

DC Coupling – It is used to pass the DC component of the signal.

q

Ground Coupling – It grounds the input channel. This is used when
the channel is inactive.

dB Reference
This is the level that is used in displaying data from this channel on a dB
scale, dB = 20 log (level/levelref).
Reference Chans
The user may select which channels may be used as reference channels
when this channel is used as the response channel in a frequency response
function (complex). If NONE is selected, only transmissibility (real) may
be displayed when this channel is used as the response.
5.2.2 Controls
The CONTROLS Menu option displays the Test Settings Window. This window has six
tabs. They are:
q

Acquisition

q

Control Setup

q

Test File Setup

q

Data Storage

q

Database

q

Print Automation

At the bottom of each tab are the four standard Windows Command Buttons.
q

OK

q

Cancel

q

Apply

q

Help

After the test starts only the Cancel and Help buttons are available. Test parameters
cannot be changed. Please refer to the Windows documentation for information about
these buttons.
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5.2.2.1 Test Settings
The six Test Settings Window Tabs are described below.
Acquisition
The Acquisition Tab (Figure 5-3) sets the sampling and averaging parameters for data
acquisition.
q

Max Frequency (Hz)

Select the data acquisition maximum frequency: 50, 100,200,500, 2K, 5K, 10K and 20K.
This value must be greater than or equal to the control maximum frequency. Set Where?

Figure 5-3. Acquisition Tab of TestSettings Window

q

Lines of Resolution

q

Select the number of spectral lines within the Max Frequency: 100, 200, 400,
800, (1600 & 3200 optional). The frequency "distance" between each line is
known as the Delta F (Max Freq. LOR = F). A high number of lines of
resolution in a test yield greater accuracy, however speed is compromised.
Control Degrees of Freedom
This is the statistical averaging parameter for the control PSD calculation. See
Chapter X for more information on DOF.

q

Mon Averaging
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Select the type of averaging for monitor and measurement channels.
Exponential sets a continuous exponential averaging as is done for the control
channel. Linear specifies linear averaging for a fixed number of frames before
averaging is halted.
Mon Degrees of Freedom
This sets the discount exponent for exponential averaging or the number of
frames for linear averaging (number of frames = DOF/2).

q

Overlap Processing
Allows user to initiate overlap processing. This is an analysis format that uses a
mixture of old data and a portion of the new data signal on a segmented basis.

Control Setup
The Control Setup Tab (Figure 5-4) has five toggle button boxes. The boxes and their
buttons are described below.
q

Strategy – Allows user to assign the control strategy that can be applied to multichannel control averaging:
Average – The arithmetic average of the control channels at each spectral line.
This is the default.
Minimum – The minimum value of the control channels at each spectral line.
Maximum – The maximum value of the control channels at each spectral line

q

Mode - Allows the user to define how the test starts.
Manual – The user may make modifications to the test while it is running.
Automatic – The user may only make modifications to the test while it is
running if Manual is first selected.
Auto Only – No modifications may be made to the test while running.

q

6-24

Stored Drive
This allows the user to speed up equalization for repetitive tests by loading a
compensated drive signal from a previous test. This box can be set to Yes, No or
Verify. Selecting Yes would use a pre-stored drive signal at the start of the test.
Selecting No means the test will start normally with a scaled drive signal and the
frequency content of the reference profile. Selecting Verify will result in the user
being prompted whether to abort the test, use the pre-stored drive, or start the test
normally.
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Figure 5-4. Control Setup Tab of Test Settings Window
q

Loop Gain
This is the loop gain expected through the amplifier, shaker and transducer
system. This setting is used to optimize control dynamic range. This box can be
set to Low, Medium or High. The Low setting tends to decrease the oscillations,
but makes the control respond slower to step changes in GRMS changes. Medium
is the standard while the High setting is about 2 X the standard feedback factor.
The loop gain controls the feedback factor, which in turn controls the level
scaling, based on a ratio of the control to reference GRMS’s. This allows the
system to respond more quickly to dB gain changes per loop rather than relying
on simple spectral line feedback. There is a range of approximately 5:1 between
Low and High. This factor helps control the “hunting” in control spectral line
levels that is sometimes observed.

q

Spectral Smoothing
This box can only be set to Off or On. Smoothing will remove the noise from the
signal by the use of a filtering process. Similar to the loop gain, the user can
control how the system control loop will respond to very small deviations in the
control to reference GRMS ratio. If the ratio is small (like less than 1 dB), then
the control loop will optionally ignore trying to compensate for these changes
using attenuator (like a dB level shift). Instead, the normal control loop spectral
line feedback is used. In cases of larger shifts (e.g. > 1 dB), then the attenuator
will be used to help shift the drive output. The amount of shift is basically
controlled by the loop gain. In any case, where the shift is > 1 dB, the attenuator
will still be utilized irrespective of the noise filtering setting.
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Test File Setup
The Test File Setup Tab (Figure 5-5) shows the currently loaded setup parameters files.
The boxes from top to bottom are:
o Test File
o Channel File
o Profile File

o Schedule File
o Sequence File
o Test File
Description

Figure 5-5. Test File Tab of Test Settings Window

The user may either define each file through the corresponding file’s dialog box or load
the file directly from the Test Settings Dialog Box by using the browse buttons.
Data Storage
The Data Storage Tab (Figure 5-6) is used to select data storage options.
q

File Name Toggle Button Box – Defines the file where data will be stored.
The toggle buttons are: Auto Generate, Query and Default.

Auto Generate - Creates a unique file name based on the type of test, date and time
that the test started.
Query - Prompts user for a file name after starting test.
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Default – All test data is saved in a default file named Sine on
RandomTestData.sdd. The default file is overwritten each time the test
starts.

q

Check Boxes
Save On Level Change – Saves a frame of data each time the test schedule
changes level
Save Every X Second(s) – Saves a frame of data at each predetermined interval.
Enter the number of seconds between data saves. If
not used carefully file sizes can become quite large.
Save On Alarm – Saves a frame of data each time the system alarms. Used to
keep track of when the data trace exceeds the alarm lines on a
profile.
Save On External – Saves a frame of data with each pulse from an external
source
Note – Any combination of these options may be used. PUMA Sine on Random
will always save the last frame of data on <ABORT>, <STOP> or upon
normal Test Completion.
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Figure 5-6. Data Storage Tab of Test Settings Window

Database
The Database Tab (Figure 5-7) has a check box, three toggle buttons and three dropdown list boxes. They are described below.
When the Enable Storage checkbox is checked the Notice Dialog Box (Figure 5-8) is
activated and the Select Test drop-down lists become active.
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Figure 5-7. Database Tab of Test Settings Window

Figure 5-8. Enable Storage Check Box Notice Dialog

Print Automation
The Print Automation Tab (Figure 5-9) is an optional feature that allows the user to
define a series of print layouts to be automatically printed at the end of each test.
Depending on graphics options, each layout can be up to 8 pages.
q

Command Buttons
The Add, Remove, Save and Load buttons are used to build, access or modify
the table of print layouts from existing print layouts.
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Check Boxes
Enable Printing

q

The check box will enable /disable automatic printing.
AutoScale
This check box will enable / disable automatic scaling of the X and Y data so it
will fit on the graph. It is recommended this option be checked.
q

Radio Buttons
ALL FRAMES prints each frame of data saved during the test (see Data Storage
above).
LAST FRAME prints only the final frame of the test.

Figure 5-9. Print Automation Tab of Test Settings Window

5.2.3

Reference Import

The REFERENCE IMPORT Menu Option displays the Reference Import Screen. See
Figure 5-10.
q

File Select Box
Clicking on the browser button at the end of the File Select Box launches an
Open Dialog and enables the user to select the file to be used. Once selected,
the file name/path appears in the File Select Box.

q

Reference Profile Listing
This lists available records in the file to be imported as the reference.

q

Profile Range
Enter the minimum and maximum frequencies of the test.
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q

Abort Line Settings
Enter the positive and negative abort ranges in dB.

q

Alarm Line Settings
Enter the positive and negative alarm ranges in dB.

q

Acquisition Rate
This is the acquisition rate of the imported reference data as defined on the
Acquisition Tab of the Test Setings Dialog.

File Select Browser

Reference Profile Listing

Figure 5-10. Reference Import Window
q

Lines of Resolution (LOR)
This is the number of spectral lines in the imported reference data as defined on
the Acquisition Tab of the Test Setings Dialog.

q

Delta Frequency (ÄF)
This is the frequency spacing of the imported reference data.

q

Command Buttons
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<OK>

This button accepts the changes made and closes the
dialog box.

<CANCEL>

This button cancels any changes made and closes
the dialog box.

<HELP>

This button opens the on-line help option and
enables the user to find answers to questions about
the system / settings.

Broadband Profiles

The BROADBAND PROFILES Menu Option displays the Profile Settings Window. See
Figure 5-11. There will always be a Control tab. Next to the word Control in the tab is
the channel number or numbers assigned as control channels in the channel table. This
tab sets up the reference profile for the control channels. The Profile Settings Tabs format
is outlined below.
5.2.4.1 Profile Settings
Reference profiles are defined in terms of slopes and frequency/amplitude breakpoints.
A combination of up to 500 slopes and frequency/amplitude breakpoints may be used to
define a profile. Definitions of each parameter is provided below:
Hint: to insert or delete a line in the table, highlight the line by clicking on the line
number to the left and use the keyboard insert/delete keys.
q Status
Toggle on/off breakpoint or slope in the profile table.
q Frequency
Enter the breakpoint frequency in Hz.
q

G2/Hz
Enter the amplitude for the breakpoint in G2/Hz.

q

Slope (dB/oct)
Enter the slope for a segment in dB/octave.

q

-Alarm (dB)
Enter negative alarm tolerance for this breakpoint in dB (negative sign is not
necessary).

q

+Alarm (dB)
Enter positive alarm tolerance for this breakpoint in dB.
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q

-Abort (dB)
Enter negative abort tolerance for this breakpoint in dB (negative sign is not
necessary)

q

+Abort (dB)
Enter positive abort tolerance for this breakpoint in dB

Up to 500
+/- Alarm dB Columns
profiles
Any time the plot parameters exceed preset alarm
available
using
lines a log entry is made. Whether the test will abort
the
slide
bar.
or ignore is determined by the setting in the schedule.
See paragraph 5.2.4.1 for more details.
Delta F = Frequency
Frequency Column
differential.
Entries must be within the
GRMS = GRMS of the
Profile Range below.
Profile.
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+/- Abort dB
Columns
The Abort
indicator lines
are the
outermost of
the plot.
When a test
exceeds the
preset levels
indicated by
the lines, the
test aborts.
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An optional
slope.

Y Axis

Status
An entry in
the column
toggles from
Off to On and
the profile
information is
used in the
test. The user
can deny the
profile to the
test by setting
the profile
Off.

X Axis

Spreadsheet
data can be
printed.

Profile
Range

Acquisition
Range
The range of
data being
acquired by
PUMA.

Amplitude (Y-Axis)
Units Selection Buttons

Alarm/Abort
Range
The range
monitored by the
Alarm and Abort
subroutines during
the test.

Plot Preview
Window.

File
Selection
Box.
See
paragraph
3.3.1.
Command
Buttons

Figure 5-11. Profile Settings Window for Broadband Profiles

q

Alarm/Abort Range
Enter the minimum and maximum frequency range over which tolerances will
be checked during the test. Range must be within Acquisition Range minimum
and maximum frequency.

q

Profile Range
Enter the minimum and maximum range for the profile.

q

Acquisition Range
Display of Acquisition minimum and maximum frequency defined in the
Control Settings.
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Delta F
Display of the frequency spacing of data (Delta F = bandwidth / # lines of
resolution).

q

GRMS
Displays total GRMS of the entered profile.

Hint: To rescale the entire reference and maintain profile shape place mouse pointer in
the GRMS box and right-click the mouse. A prompt will appear for a “New GRMS.”
Enter the new GRMS and click “OK.” The breakpoints will be scaled to achieve the
desired level.
5.2.5 Tone Profiles
The Tone Profiles (narrowband) are set with the Tone Profiles Dialog. See Figure 5-12.
This dialog is similar to the Broadband Profiles Dialog except for the following:
q

Sweep Range
4 Along with the start frequency there are listings of the minimum and maximum
ranges for the tone.

q

Tone Parameters - The Tone Parameters categories are:
5 Sweep Mode - Choose Log or Linear
6 Points Per Sweep - Range is: 200, 400, 800, 1600
7 Tone Smoothing - Choose Off, Automatic, Low, Medium or High
8 Initial Sweep Direction - Choose Up, Down or Stationary
9 Sweep Type - Choose Rate or Timed
10 Sweep Time - User defined for a Timed Sweep Type
11 Sweep Rate (Oct/Min) - User defined as applicable.

q

Tone Duration
12 Duration Type - Choose Sweeps, Timed or Unlimited
13 Time - User defined for a Timed Duration Type
14 Sweeps - User defined for a Sweeps Duration Type

q

Harmonics Command Button - What does this do?
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Figure 5-12. Profile Settings Window for Tone Profiles

5.2.6

Schedules

The SCHEDULES Menu Option displays the Schedule Setup Window. It has two tabs
labeled Level Schedule and Test Schedule. Both are discussed below. During setup if no
schedule is defined the default will be applied automatically. It is approximately 45
minutes.
5.2.6.1 Level Schedule
The Level Schedule Tab (Figure 5-13) is used to set the duration of the test. This
duration can be specified as a single level or multiple levels. The Level Schedule table
parameters are:

q
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Toggle on/off level segment in the Level Schedule table.
Hint: To insert or delete a line in the table, highlight the line by clicking on the
line number to the left and use the keyboard insert/delete keys.
Level (dB)
Enter the test level in dB relative to full test level (from –80 to 0 dB).

Time At Level
Time spent on this
schedule prior to
continuing

Two
Tabs
Level
Column
The decibel
level
required for
this stage of
the test

Time To Level
Time period
Alarm Action
required reaching
Action
required if
the next level once
data
trace
exceeds
current level is
either
alarm
range.
finished.

Status
Column
Default is
OFF. Toggled
ON when info
entered.
Schedules
turned OFF
will not be
executed.

Acquisition Range
Start Up / Shut
Down Rate of
Schedule
Level Increment The amount
raised/lowered
between schedule
steps.
Initial Test Level The level at which
the test will start.
Time At Initial
Level Time spent at initial
level prior to
moving.

FSB
See
paragraph
3.3.1

500 Schedules
available using
the slider.

Figure 5-13. Level Schedule Tab of Schedule Setup Window
q

Time at Level
Enter the time to remain at this level before continuing to the next.

q

Time to Level

q

Enter the time to reach the next level once this level has completed.
Alarm Action

q

Select Abort or Ignore. If the data trace exceeds the alarm lines at a
predetermined level the test can be aborted.
Acquisition Range
15 Startup Rate (dB/sec
Enter the rate in dB/sec to proceed from the initial test level to full level.
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16 Shutdown Rate (dB/sec)
Enter the rate, in dB/sec, at which to shutdown after an abort or completion of
the test.
17 Level Increment (dB
Test level step increment.
18 Initial Test Level (-dB)
Enter the initial level relative to full test level at which to equalize and begin
checking alarm and abort tolerances.
19 Time at Initial Level (Loops)
Enter the number of control loops to complete before continuing to full level
in the Automatic mode. The actual time will depend on test bandwidth and
resolution.
5.2.6.2 Test Schedule
The Test Schedule Tab (Figure 5-14) is used to schedule a sequence of test profiles and
level schedules. For Test Scheduling all profiles must use the same acquisition
parameters. For scheduling of tests with different acquisition parameters or different
types of test (e.g. sine) you must use Mission Simulation. After the test starts the Test
Scheduling Dialog will appear. Its table is the same as the Test Schedule Tab's table
except for the Current Cycle column. A box around the entry in that column indicates
the active cycle.
Profile Column
A file name is
entered to
enable the user
to use multiple
profiles.
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Level Schedule
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hold multiple
schedules.
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RH Browse
Buttons
link the
user to
previously
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Cycles Column
If this row of data holds
multiple schedules, list
the number of times to
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Status
An ON
setting
indicates
that the
file data
is being
used in
the test

Delay
Column
Enter the
delay
required
between
schedules.
Run
Schedule
Button
Allows user
to start a
schedule not
previously
active.

FSB
See
paragraph
3.3.1

Figure 5-14. Test Schedule Tab of Schedule Setup Window

The Test Schedule table parameters are:
q

Status
Toggle on/off level segment in the Test Schedule table.
Hint: to insert or delete a line in the table, highlight the line by clicking on the
line number to the left and use the keyboard insert/delete keys.

q

Profile
Select the test profile from previously stored profiles using the browser button
on the right.

q

Level Schedule
Select the level schedule for this test profile from previously stored level
schedule files using the browser button on the right.

q

Delay
Enter the delay in hours:minutes:seconds before executing this test in the
schedule.

q

Cycles
Enter the number of times to repeat this profile and schedule before continuing
on the next profile.

q

Run Schedule Button

q

Click on the run schedule button to execute the loaded Test Schedule.
Command Buttons
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Below the tabular data display is a File Selection Box with a <RUN SCHEDULE>
Command Button to the right of it.
5.2.7

Limits

The LIMITS Menu Option displays the Limit Settings Window. It has two tabs labeled
Safety Limits and Shaker Limits. Both are discussed below.
5.2.7.1 Safety Limits Tab
The Safety Limits Tab (Figure 5-15) is used to set the parameters for safety checks. The
checks are divided into 6 areas:
q

Alarm Lines
Specify the portion of the spectral lines that must exceed the alarm tolerances to
trigger an alarm. This can be specified in either an absolute number of spectral
lines or in a percent of the total spectral lines.

q

Abort Lines
Specify the portion of the spectral lines that must exceed the abort tolerances to
trigger an abort. This can be specified in either an absolute number of spectral
lines or in a percent of the total spectral lines.

q

Sigma Clipping
Enter the Sigma Clipping level. Sigma Clipping limits the ratio of peak to RMS
allowed in the drive signal. Low values of Sigma Clipping can significantly clip
the drive signal and result in a loss of control dynamic range.

q

GRMS
Specify the GRMS levels for the control signal at which an alarm or an abort
will be triggered. This may be specified in either dB above the Reference
Profile or in Absolute GRMS.

q

Loop Check

q

Specify the parameters to be used in the pre-test loop check.
Max Noise (mV RMS)
Enter the maximum acceptable noise level measured on control channels prior
to output of a drive signal.
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Figure 5-15. Safety Limits Tab of Limit Settings Window

q

Max Drive (mV RMS)
Enter the maximum drive output level during loop check. If the control signal
is not detected 3 dB above the measured ambient noise at this drive level the
system is considered to be open loop and the test will not start.

q

CSL Sensitivity
Control Signal Loss Sensitivity Settings.

Standard
This method provides the safest control signal loss detection mode and will usually
detect cases where an accelerometer has fallen off a test specimen, but remains on the
test fixture (bouncing about).
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1) Measure the ambient noise (in RMS volts) on each control channel with
the drive off.
2) Increase the drive until all control channels exceed the measured ambient
noise by 6dB.
3) Measure the RMS of each control channel at the current drive level and
store the RMS level.
If, at any time during a test, any one of the control channel's RMS values goes more
than 3dB below the above stored RMS level, the test is aborted.

CAUTION
The Low selection should only be used
in the Manual Mode and never left
unattended.

Low
This method is good for large structures that may have large differences in the gains
of the control channels.
1. Measure the ambient noise on each control channel (with drive off) and set
the control signal loss threshold to 3dB above this level.
2. If, at any time during a test, any one of the control channel's RMS values
goes below the above stored RMS level, the test is aborted.
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WARNING
The OFF selection can cause severe
over-test if the control signal is lost due
to broken cables or malfunctioning equipment and the drive signal is increased in
an attempt to compensate for the low
control level.

CAUTION
The OFF selection should only be used
in the Manual Mode and never left
unattended.

Off
It may be useful in noisy environments for cases where control signal loss aborts have
occurred and the equipment is known to be working properly.
1. Disable the control signal loss after the loop

5.2.7.2 Shaker Limits Tab
The Shaker Limits Tab (Figure 5-16) of the Limit Settings Window allows safety limits
to be entered for shaker tables. Tables may be saved and recalled for laboratories with
multiple shaker systems. If a test setup will exceed the limits in this table the system will
provide a warning and prevent the test from being run.
Shaker limit parameters are:
q

Acceleration
Enter the maximum acceleration (+g, -g) for the shaker system.

q

Velocity
Enter the maximum velocity (+in/s, -in/s) for the shaker system.

q

Displacement
Enter the maximum displacement (+in, -in) for the shaker system.
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Voltage
Enter the maximum input voltage (+V, -V) of the shaker amplifier.

q

Symmetrical Limits
Check this box to enter peak value limits only once (in positive value boxes)
when symmetrical. The opposite limit is assumed to be the negative of the
entered value. This makes table entries easier. In either symmetric or nonsymmetric limit tests, the limit value is still assumed to be zero to peak.

Figure 5-16. Shaker Limits Tab of Limit Settings Window

5.2.8 Remote Control Interface
The REMOTE CONTROL INTERFACE Menu Option displays the Remote Control
Interface Window. See Figure 5-17. This window allows the user to specify actions to
occur when TTL status lines on the Remote Communications Interface go high or low.
The action options are:
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q

q

q

q

q
q
q

View Menu

Abort – abort the running
test
Start – Start the currently
loaded test
Stop – Stop the running test

q

Resume – Resume the
stopped or aborted test

q

Load
Test
Start
Full
Level

High Action - Lo Action
Choices
q Load
q
Profile
q Stop
q
q Off
q

q

q

Load
Schedule
Resume
Abort

Load Schedule – Load a
stored test schedule
Load Profile – Load a
stored test profile
Full Level – Bring
running test to full level
Load Test – Load a
stored test setup

Message
Allows the
user to define
a description
of the channel
being used.

Segment
Name
Click a
RH
browse
button to
insert a
file name

FSB
See
Paragraph
3.3.1

Figure 5-17. Remote Control Interface Window

Remote Control Interface setup parameters:
q

Input Line Number
Input status line channels 1 thru 16

q

High Action
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Each channel has a default entry (Off) and a pull-down menu with eight action
menu choices.
q

Lo Action
Same as the High Action.

q

Segment Name
Each row has a Browser Button that displays the {Open} (File) Dialog Box to
allow user to find the desired file.

q

Message Column
Enter text identifying Remote Communications Interface Line.

5.2.9 Security
The SECURITY Menu Option displays the Update Security File Window. See Figure
5-18. This is a purchase option. This window is used to update the security file by either
adding or deleting employees names, their privileges or both. User privileges are added
by highlighting the privilege in the Privilege Table.

Figure 5-18. Update Security File Window
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Chapter 6 - View Menu
6.1 Introduction
When VIEW is selected from the Menu Bar, the image shown in Figure 6-1 will display.
Note that selections have been made. The checkmarks indicate items that will be seen
either in a window or on the desktop during the test. The number of channels being
monitored depends on the package purchased. There can be 4, 10, 16 or 32 channels
available.

Figure 6-1. View Menu

6.2 View Submenus
Each of the remaining VIEW submenus is described next.
6.2.1

Toolbar And Status Bar

When the TOOLBAR and/or STATUS BAR options are selected, the Toolbar buttons and
Status Bar information will display. See Figure 6-2.
6.2.1.1 Toolbar
The TOOLBAR buttons are shortcuts for various menu items. The first six, and the last
three, are standard Windows Toolbar buttons. These are described in your Windows
documentation. Information for the other buttons, CHANNEL SETUP, BROADBAND
PROPERTIES, TONE PROPERTIES, and SETUP SCHEDULE, can be found later in this
chapter.
6.2.1.2 Status Bar
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The Status bar gives information about various activities currently running on the system.
A message displays whenever the cursor touches a shortcut icon. It also has three boxes
that act as text boxes to indicate certain functions are available.

Current Display Settings
(PUMA Desktop Toolbar)

Toolbar
Status Bar

Figure 6-2. Toolbars and Status Bar

6.2.2

Test Control

When TEST CONTROL is selected from the VIEW menu, the Test Control images shown
in Figures 6-3 and 6-4 will display.
6.2.2.1 Test Control Common Components
The seven common buton controls of the Test Control are described below.
Start / Stop
Select the <Start> button to begin the currently loaded test. The test is running as long as
the button is depressed and reads Stop. When the test is stopped the button is raised and
reads Start.
q

Restart
Select the <Restart> button to restart the test after a test has been stopped. The test
continues from the point at which it was aborted.
q

Pause Continue
Select the <Pause> button to pause the currently loaded test. The button label will change
to <Continue>.
q

Manual
Select the <Manual> button to run the test in the manual mode. The TEST CONTROL
COMPONENT TAB displays to enable control of the sweep direction and rate.

q

Reset Avg.
Select the <Reset Avg.> button to reset the control-averaging algorithm.
q

6-48

BETA RELEASE

2400-0133

Sine on Random Operating Manual

View Menu

Save
Select the <Save> button to manually save the current frame of data to a file.
q

Abort
Select the <Abort> button to manually abort the currently running test. The user may also
hit the orange Abort Test <F12> key on the keyboard. An optional External Abort
Actuator Button is available from Spectral Dynamics. Actuating this option completely
stops the test and the user is queried to save the test results or not. This button is colored
white when the test is not running and colored red during the test.
q

6.2.2.2 Broadband Tab
The control components of the TEST CONTROL BROADBAND TAB are described below.
There are three buttons and a slider used to control the test.

Figure 6-3. Test Control
In Auto Mode
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In Manual Mode
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Step Up
Select the <Step Up> button to increase the test one schedule level (as defined in Test
Schedule Dialog).
q

Step Down
Select the <Step Down> button to decrease the test one schedule level (as defined in Test
Schedule Dialog).
q

Note: A schedule must be loaded to have the <Step Up> and <Step Down> buttons
respond.
Drv Update
Click the <Drv Update> button to toggle (on/off) the updating of the drive signal. When
ON it appears depressed and the window is highlighted. On is commonly used for closed
loop control. Turning it OFF effectively replays the same drive signal continuously and
the Alarm/Abort limits are inactive. Use with caution.
q

Slider
The slider allows the user to change the level of the test more than just one increment, as
does the step up/down buttons.
q

6.2.2.3 Component Tab
The three buttons, two drop down lists and single text box of the TEST CONTROL
COMPONENT TAB are described below.
Component Drop-Down List
The choices are: NEED INFO

q

Status Drop-Down List
The choices are: : NEED INFO
q

Sweep Direction Buttons
The <Swp UP> and <Swp Down> buttons change the direction of the sweep.
q

Sweep Rate (Oct / Min)
The text box reflects the value chosen with the <Change Rate> button.
q

6.2.3

Status Panel Options

When any of the BROADBAND STATUS, CHANNEL STATUS, CYCLE STATUS, TONE
STATUS, LEVEL STATUS, TEST STATUS or TEST SCHEDULE STATUS options are selected,
the Status Panels shown in Figures 6-5 or 6-6 through 6-11 will display.
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6.2.3.1 Test Status
When TEST STATUS is selected from the VIEW menu, the Test Status panel shown in
Figures 6-5 and 6-6 will display. The Test Status Panels give information about the
currently loaded test.
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Figure 6-5. Status Panels

6.2.3.2 Cycle Status
Need Graphic and info. See Figures 6-5 and 6-7.
6.2.3.3 Level Status
When LEVEL STATUS is selected from the VIEW menu, the status panel shown in Figures
6-5 and 6-8 will display. This panel gives information about the level of the currently
loaded test.

Current Test
Status
Elapsed
Test Time
Remaining
Test Time
and Progress
Bar
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Figure 6-6. Test Status Panel

Figure 6-7. Cycle Status Panel

Current Test
Level
Schedule
Level
Elapsed Level
Time
Remaining
Level Time
Figure 6-8. Test Level Status Panel
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6.2.3.4 Tone Status
When the TONE STATUS option from the VIEW menu is selected, the Component Status
panel shown in Figures 6-5 and 6-9 will display. This panel gives information about the
level of the currently loaded test.
6.2.3.5 Broadband Status
Clicking on the BROADBAND STATUS Menu Option of the VIEW menu will cause the
Broadband Status Panel (Figure 6-10) to appear. It displays current control, drive and
test levels as defined in BROADBAND PROFILES in the SETUP Menu.

Current Test
Level
Schedule
Level
Elapsed Level
Time
Remaining
Level Time
Figure 6-9. Tone Status Panel Need info.

Test Level in
dB
Control Level
(GRMS)
Drive Level
(RMS)
Figure 6-10. Broadband Status Panel
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6.2.3.6 Channels Status Panels
When a CHANNEL STATUS PANELS Menu Option is selected a window similar to the one
shown in Figure 6-11 will display. The Channel Status windows give GRMS information
about the channels in four-channel increments. The measurement is to the nearest one
thousandth. If the 10-channel package is purchased the channel output for channels 11
and 12 will be greyed out.

GRMS of Each
Individual Channel

Figure 6-11. Typical Channel Status Panel

6.2.3.7 Test Schedule Status
When the TEST SCHEDULE STATUS Menu Option is selected from the VIEW menu the
Test Scheduling Dialog appears. See Figure 6-12.
This dialog gives information about the test(s) currently loaded. If the rows are blank,
schedule(s) are not loaded in the SETUP Menu portion of the test. To load schedules
navigate the path:
Setup ï Schedules ñ Schedule Setup Window ñ Test Schedule Tab.
Load the desired profiles and schedules using the browse buttons then click the < RUN
SCHEDULE> button.

Figure 6-12. Test Scheduling Window
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Message Log Font

When MESSAGE LOG FONT is selected from the VIEW menu, a standard Windows font
dialog box appears. Refer to the Windows documentation for further information.
6.2.5 OLE App Launcher
The OLE Application Launcher is a link to the folder holding any active-x applications
written by the user. See Figures 6-13 thru 6-17.

Figure 6-13.

Figure 6-14.
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Figure 6-15.

Figure 6-16.

6.2.6 Current Display Settings (PUMA Desktop Toolbar)
Tucked between the menu bar and the tool bar is the PUMA Desktop Toolbar accessed
with the CURRENT DISPLAY SETTINGS Menu Option in the VIEW Menu. When selected,
each item in the list will arrange the desktop in a predetermined layout. Each template
listed has its particular components that are laid out in a specific arrangement. The user
can modify each template and arrange the screen components to suit their needs.
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Chapter 7 - Test Menu
7.1 Introduction
When the TEST option is selected from the Random Menu, the image shown in Figure
7-1 displays. After the test begins, the options change as shown in Figure 7-2. Most of the
commands can also be issued from the Test Control. See Chapter 6.

Figure 7-1. The Test Menu Options Prior To A Test

Figure 7-2. The Test Menu Options During A Test (Need SOR)
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7.2

Test Submenus

Each of the items on the TEST menu is described in the following paragraphs.
7.2.1 Abort
The ABORT menu option allows the user to abort the currently running test.
7.2.2 Start
The START menu option starts the test if either of two criteria has been met:
q

A previous test file has been loaded

q

Test parameters have manually been input for all phases of the test.

After the test starts the label changes to read STOP.
7.2.3 Restart
The RESTART menu option restarts the test from the same point that the test was stopped
with a PAUSE, STOP or ABORT menu option.
7.2.4 Pause
The PAUSE menu option stops the test and waits for a command to continue or stop.
7.2.5 Manual
The MANUAL menu option allows the user to take manual control of the test so that
parameters other than the ones originally started with can be used.
7.2.6 Step Up
The STEP UP menu option allows the user to manually increase the test one schedule
level while in the manual mode.
7.2.7 Step Down
The STEP DOWN menu option allows the user to manually decrease the test one schedule
level while in the manual mode.
7.2.8 Drive Update
The DRIVE UPDATE menu option allows the user to toggle (on/off) the updating of the
drive signal. Turning it off effectively replays the same drive signal continuously. Use
with caution.
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7.2.9 Reset Average
Selecting RESET AVG will begin Monitor and Auxiliary Averaging in either Linear or
Exponential Mode.

7.2.10 Save
The SAVE menu option allows the user to save the current frame of data to a file.
7.2.11 Message Log
The Message Log is the file of information being generated and is displayed as the test is
running. The MESSAGE LOG submenu has submenus of its own. See Figure
7-3. There is a Pre-Test and Post-Test Dump and a Message Priority selection with three
submenus of its own. The submenus are discussed below.
7.2.11.1 Pre-Test Dump
When the test is started PUMA performs a PRETEST DUMP. It lists the
specifications of the test and normally includes: More required?
• Test Name (path)
• Control DOF Value
• Channel Table (path)
• Auxiliary DOF Value
• Control Profile (path)
• Resolution Value
• Additional Channel
• Min. Frequency Value
Profile Paths
• Schedule (path)
• Max. Frequency Value
7.2.11.2 Post-Test Dump
The POST TEST DUMP lists any errors and the levels encountered during the test
cycle. One example would be a Max Error Signal report.
7.2.11.3 Message Priority
Message Priority The three levels of Message Priority are HIGH, MEDIUM and
ALL. While it is highly recommended that the default (All) be used, the other
choices are offered for those users that continually run the same test or repeat a
number of cycles of the same tests and do not need to see all the log file
messages
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Figure 7-3. Message Log Sub-Menus
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Chapter 8 - Data Menu
8.1 Introduction
When you select the DATA option from the menu bar the menu shown in Figure 8-1 will
display.

Figure 8-1. The Data Menu Prior to Any Test Being Run

The DATA menu consists of: DISPLAY (of Sine on Random Test Data.syn file), CHOOSE
REPORT, FILE SUMMARY INFO, GIM IMPORT/EXPORT, SUMMARY, and CALCULATOR.

8.2

Data Submenus

All of the DATA Menu items are described next.
8.2.1 Display
The DISPLAY option is not available until after the testing begins. After the required
parameters are input and the test has been started, the menu option reads: Display Sine on
Random Test Data.syn. See Figure 8-2. This is a synopsis file that summarizes the most
recent test that has been run.
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Figure 8-2. The Data Menu After Starting A Test. Need new Graphic.

8.2.2

Choose Report

The CHOOSE REPORT option activates an OPEN Dialog Box similar to the SAVE AS
Dialog Box, which allows the user to search for and select the file that contains the
required report. See Figure 8-3.

Figure 8-3. Results of Selecting Data ⇒ Choose Report
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File Summary Info

When the FILE SUMMARY INFO option is selected, the Document Properties Dialog
Box shown in Figure 8-4will display. It has two index tabs, labeled: Summary, and
Statistics, which are described next. At the bottom are the standard Windows buttons
<OK>, <Cancel>, <Apply>, and <Help>. For information about these buttons see your
Windows documentation.
8.2.3.1 Summary Tab
The Summary Index Tab contains seven fields. The first field Application, names the
software program that is currently loaded. The other six fields Author, Keywords,
Comments, Title, Subject and Template allow you to add summary information.
8.2.3.2 Statistics Tab
Figure 8-5 displays the Statistics Index Tab information. It lists ten lines of basic
information about when the file was created, how large it is, and so forth.

Figure 8-4 Document Properties
Dialog Box
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8.2.4 GIM Import/Export
The GIM IMPORT/EXPORT menu option allows the user to

NEED INFO

8.2.5 Summary
The SUMMARY menu option allows the user to
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Chapter 9 - Help Menu
9.1

Introduction

When the HELP Menu Option is selected, the menu shown in Figure 9-1 will display. This menu
consists of HELP TOPICS, TUTORIAL, HINTS, SUPPORT, STARTUP WIZARD, and ABOUT PUMA.
After the test begins the menu changes. See Figure 9-2.

Figure 9-1. The Help Menu Prior to Starting Test

Figure 9-2. The Help Menu After Starting Test
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9.2 Help Menus
The following paragraphs describe the HELP Menu Submenus.
9.2.1

Help Topics

The HELP TOPICS Menu Option launches the Spectral Dynamics On-Line Help on the website.
Figure 9-3 displays the Welcome Page. Figure 9-4 displays the result of selecting the Sine On
Random choice on the Welcome Page.

Figure 9-3. Result of Clicking on Help Topics.
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9.2.2

Sine on Random

About PUMA

The About PUMA Window (Figure 9-5) features a rolling, bouncing cube with a picture
of a Puma and the CATS PUMA logo. The right side of the window displays version,
build and copyright information.

Figure 9-5. The About Puma Screen
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